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IMPORTANT: PLEASE READ THE FOLLOWING TEXT CAREFULLY.

The information contained in this document is property of CYPE Ingenieros, S.A. and can neither be reproduced nor transferred partially or
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This document and the information it contains form an integral part of the documentation accompanying the User License of CYPE
Ingenieros S.A. programs and cannot be separated. Therefore it is protected by the same laws and rights.

Do not forget to read, understand and accept the User License Contract of the software of which this documentation forms part of before
using any component of the product. If the terms and conditions of the User License Contract are NOT accepted, immediately return the
software and all the elements accompanying the product to where it was first acquired for a complete refund.

This manual corresponds to the software version indicated by CYPE Ingenieros, S.A. as Reinforced concrete cantilever walls. The informa-
tion contained in this document substantially describes the properties and methods of use of the program o programs accompanying it.
The information contained in this document could have been modified after its mechanical edition without issuing a warning. The software
accompanying this document can be submitted to modifications without issuing a previous warning.

CYPE Ingenieros, S.A. has other services available, one of these being the Updates, which allows the user to acquire the latest versions of
the software and accompanying documentation. If there are any doubts with respect to this text or with the software User License or for
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Presentation

Reinforced concrete cantilever walls is a program for the design and analysis of reinforced
concrete soil retaining cantilever walls. It carried out an automatic initial design of the geometry, section reinfor-
cement and geometric design of the wall footing reinforcement.

Different soil layers may be defined as well as indicating the presence of the water table, rock layers
and loads on the infill and backfill.

Different construction phases or stages may be defined.

Allows for design in seismic conditions.

Provides reports on the data introduced, drawings of the phases, analysis results, force diagram dra-
wings and deformations for each phase or selected phase group, and reinforcement layout drawings.

A simple and easy to follow assistant is also available to generate the wall and its loads.

Reports may be obtained via printer (with optional preliminary view, page setup, etc.) or have them
generated as HTML, PDF, RTF or TXT files.

Drawings can be exported to the printer, in DXF or DWG format to any graphic peripheral.

Reinforced concrete cantilever walls - Calculations manual 5
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1.1. Onscreen help
CYPE programs have on screen help icons to provide the
user with the necessary information on the program me-
nus, dialogue boxes and options.

There are four different ways to access the help options:

1.1.1. Pressing F1

To obtain help on a menu option, press F1. All the icons
with help explanations available will be highlighted in blue.
If you wish to obtain help on an option within a menu, ha-
ving pressed F1, unfold the menu and click on the desired
option.

1.1.2. Question mark icon

A question mark icon can be seen at the top right
hand corner of the title bar. Specific help on a program op-
tion can be obtained the following way: click on the ques-
tion mark icon then unfold the menu containing the option
for which the help is sought and click on the option. A win-
dow will appear containing the required information. This
option provides the same information as when the F1 key
is pressed.

This help can be deactivated in three ways: by clicking on
the right mouse button, by clicking on the question mark
icon or by pressing the Esc key.

You can equally obtain information on the toolbar icons.
Upon selecting the question mark icon , the icons will
be highlighted in blue (as with the F1 option). By then
clicking on the icon, the help information will be displayed.

Option windows that open within the program also contain
the question mark icon in their title bar. By clicking on it, the
option or icon help can be accessed.

1.1.3. Book icon

Within the title bar of several windows, an open book icon
can be found which upon clicking on it will display ge-

neral information on the contents of the window.

1.1.4. Quick guide

The option information displayed using the F1 key can also
be consulted and printed out by selecting Help > Quick
guide. These explanations are those corresponding to the
options found within the screen tabs.

1. Program introduction



2.1. Parts of the wall
The wall is considered to be composed of several different
parts:

• Wall. Elevation of the wall from its start to the top of the
wall.

• Soil. Fills composed of one or several layers, as infill or
backfill, with optional rock layer and/or water table.

• Foundation. Strip footing below the wall. The wall may
have a shear key to provide stability against sliding.

2.2. Geometry
Below is a list of the terms used in the program:

• Backfill. Side of the wall in contact with the soil.

• Infill. Side of the wall not in contact with the soil, al-
though in some cases may have some fill.

• Height. Vertical distance between the start of the wall
and the top.

• Top thickness. Thickness of the top of the wall.

• Bottom thickness. Thickness at the start of the wall
(must be greater than or equal to the top thickness).
They may be different; a tapered wall can be defined.
When defining the geometry of the wall the thicknesses
may be fixed as of the backfill, infill or vertical mid-
plane, in which case the thicknesses are measured par-
tially to either face. The sum of both values will be the
total thickness.

• Steps. Height spans which have a abrupt change in
thickness. These are used instead of tapered to provide
easier formwork. The steps may be located at one side
of the wall or both. The reinforcement is interrupted,
bent and placed overlapping that from the span above.

• Splices. The vertical reinforcement may be divided into
several spans with overlaps/ splices. These may be
provided when designing high walls with constant or va-
riable thickness, where the reinforcement mesh corres-
ponding to its entire height cannot be placed, due to its
complexity, danger or because the formwork is not high
enough. Hence it is recommended it be carried out in
several spans. For example, the height of the formwork
used is usually 2.50m. Therefore, in order to build a 7m
high wall, three building phases must be undertaken:
2.50m, 2.50m and 2m.

The program designs reinforced concrete footings below
the wall. The depth of this footing is constant. There are
three types of footing:

• Overhang on both sides

• Overhang only to the left

• Overhang only to the right

A shear key may be defined when using any of the three
options listed above.

2.3. Loads
The general load state can be as that shown in the diagram
below:

CYPE
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Fig. 1.1.

As fills can be defined on either side of the wall, it can clearly
be seen that for each state or situation that may be conside-
red, one side will have more lateral pressures applied to it
than the other. The greater lateral pressures produce an ‘ac-
tion’ on the wall. The side which receives the smaller lateral
pressures will produce a ‘reaction’, as the wall tends to dis-
place itself towards that side, compressing it.

Hence, different types of lateral pressures can develop:

• Active pressure. The soil exerts lateral pressures on the
wall allowing enough deformation to arise in the direction
of the acting pressure so to cause the wall to fail. The
case is common when an ‘action’ is applied to the soil.

• Pressures at rest. The soil exerts lateral pressures on
the wall but hardly suffers any deformation, i.e. are null
or negligible. This is the case for walls which have an
applied movement restriction at their top due to the pre-
sence of other elements, for example in the case of ba-
sement walls which support a slab at their crown. The
value of the lateral pressure is greater than the active
pressure. It is not recommended this case be used in
the program. However, for special cases, the restriction
may be simulated by applying a horizontal load at the
top of the wall as long as the user has previously
checked that the load cancels outs any displacements
at the top of the wall.

• Passive pressure.When the wall is displaced towards
the soil, the soil is compressed and provides a reac-
tion. Depending on the displacement of the wall and the
type of soil, a percentage of this passive pressure or all
of it (however, for this to occur, large displacements are
required) can develop, unless the soil is very rigid (very
compact) or rock is present. The passive pressure does
not generally completely develop, and so it is recom-
mended a percentage of it be considered. Its value is
much greater than the active pressure. It should be
considered with caution.

The ‘elevation of the passive pressure’ is the point un-
der which the passive pressure is considered. It is never
considered above this elevation. For example, let the
starting point of a wall be at elevation ‘0’ and the eleva-
tion of the passive pressure also ‘0’. If a percentage of
the passive pressure is activated, it will only act on the
depth of the footing. If the elevation of the passive pres-
sure is increased, the resultant of the passive pressure
may result to be greater than the active pressure which
is not logical.

Check the shear force diagrams so this does not occur,
or always leave the passive pressure elevation below
the starting point elevation of the wall.

• No pressures. This situation allows for the soil which is
reacting to not develop any type of pressure and only
its weight is considered as a gravitational vertical com-
ponent on the footing.

2.4. Results

2.4.1. Wall elevation

A list of all the checks carried out by the program can be
consulted on screen (displayed as a report) when using the
design and verification options of the program. Next to
each check, the corresponding section or article of the
code which is verified is displayed. For those cases where

CYPE
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no criteria has been established, the Spanish concrete
codes and renown bibliography will be used.

It is therefore, very interesting the report be revised as it in-
dicates all the checks that have been undertaken, the des-
ign values and codes used.

It is to be consulted whenever the user deems necessary
and, if in doubt, view it to ensure all the sections are verified.

The states which are verified by the program are:

2.4.1.1. Check for shear at the base of the wall

The program verifies that the design shear at the wall-foo-
ting interface is less than what the section resists at that
joint, taking into account the concrete section and reinfor-
cement used.

2.4.1.2. Minimum thickness

The minimum thickness is limited in accordance with the
selected code.

2.4.1.3. Minimum geometrical steel ratio

In order to control any cracking that may occur due to he
deformations which may arise because of temperature ef-
fects and retraction, minimum steel areas are imposed.
These vary depending on the selected code.

2.4.1.4. Minimum mechanical steel ratio

Minimum steel ratios are required for the vertical reinforce-
ment so no fissures appear due to compressive bending.

2.4.1.5. Maximum geometrical steel area

A maximum value is imposed for the total vertical reinforce-
ment.

2.4.1.6. Minimum reinforcement spacing

So concrete may be poured correctly, the reinforcement is
to have a minimum free distance between its bars. This va-
lue used is that of the corresponding code.

2.4.1.7. Maximum reinforcement spacing

This value is limited so no areas remain without reinforce-
ment. It can be considered as it being a minimum condition
to be able to refer to it as ‘reinforced concrete’ and not
‘mass concrete’.

2.4.1.8. Check for combined axial force and bending

The resistance check of the section is carried out using the
simplified parabola-rectangle stress-deformation diagram
of the concrete to establish the area where the wall would
fail for compressive bending for the reinforced concrete
section. The check for combined axial force and bending is
implemented in all the design codes used by the program
with its indications regarding the integrations of stresses in
the section and the allowable deformation limiting values
for the materials making up the section (steel and
concrete).

When the check for combined axial and bending is under-
taken, the reinforcement is designed to be anchored so it
may be considered effective in the design. Additionally, as
the combined axial and bending forces act jointly with the
shear forces, there is interaction between both forces. This
phenomenon is taking into account by shifting the bending
moment diagram a distance equal to the effective depth in
the most unfavourable direction.

CYPE

Reinforced concrete cantilever walls10



2.4.1.9. Check for shear

The check for this ultimate limit state is carried out in the
same way as the combined axial and bending check. As
there is no transverse reinforcement in the section only the
concrete’s contribution is considered to resist the shear
forces. The value of the concrete’s contribution is establi-
shed by the term Vcu which is obtained in an experimental
manner. This term is usually included within the shear
check due to tensile failure of the section. The various diffe-
rent expressions which evaluate this Vcu component in ac-
cordance with the selected codes are considered in the
program.

2.4.1.10. Check for cracking

The limit state for cracking is checked with the aim to
control the appearance of fissures in the concrete struc-
tures. In the case of walls, fissure control is very important
as this usually occurs in the backfill face. This area cannot
usually be observed and cracks can proliferate which can
lead to reinforcement corrosion. The structure can deterio-
rate without the negative effects being noticeable. It is a
case of controlling the fissures which arise due to the loads
acting on the wall (soil, water table, surcharges…) and not
those due to material retraction and temperature variations,
which have been taken into account by considering the mi-
nimum geometric values.

To calculate the limiting crack width, a simplified process
has been followed when bending is present. Results with
an applied safety factor have been obtained compared to
those that would be obtained when combined axial force
and bending are present.

The general crack width calculation method is used for the
various codes used in the program. The results obtained
are then compared with the limits imposed by each code,
depending on the type of exposure or environment which

the structure is found to be in. To establish the ultimate limit
states for combined axial force and bending and for shear,
the load combinations for the corresponding ultimate limit
states are used. However, in the case of cracking, the load
combinations corresponding to the characteristic loads are
used. The program calculates the characteristic crack width
Wk for all the loadcases.

The calculation is repeated at different wall elevations in the
same way as is done for when checking for combined axial
force and bending and for shear. The most unfavourable
value is extracted and is compared with the limiting crack
width indicated by each code. This way, it is possible to
check whether the serviceability limit state is verified or not.

2.4.1.11. Splice lengths

The program calculates the splice lengths in accordance
with the implemented codes.

2.4.1.12. Check of the base reinforcement anchorage
at the top of the wall

The program calculates the anchorage lengths in accor-
dance with the implemented codes.

2.4.2. Wall footing

The loads acting on the wall are transformed into a discrete
force diagram along the length of the wall. It is as if a resul-
tant were changed into an applied force diagram applied
along the base of the wall, discretised in steps internally by
the program depending on its dimensions.

The states which are verified by the program are:

CYPE
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2.4.2.1. Stability check

By applying the corresponding limit state combinations, the
program checks the resultant lies within the footing and
calculates a safety factor against sliding and overturning.

2.4.2.2. Ground bearing pressures

A flat deformation diagram is assumed for the footing.
Hence, depending on the forces, a trapezoidal bearing
pressure diagram will be obtained. Tensile forces are not
admitted. Therefore, when the resultant lies outside the
central nucleus, areas without pressure will appear. The re-
sultant must lie within the footing, otherwise there is no
equilibrium. The self weight of the footing is taken into ac-
count. The program checks the mean bearing pressure
does not exceed the allowable bearing pressure and that
the maximum pressure at the edges does not exceed the
mean pressure by a percentage of the mean.

2.4.2.3. Minimum depth

The program checks that the minimum depth of the footing
specified in the corresponding code is complied with.

2.4.2.4. Anchorage lengths

The anchorage of the reinforcement is checked, placing
the corresponding hooks where required.

2.4.2.5. Minimum bar diameter

The program checks the diameter of the bars used is at
least that indicated in the code.

2.4.2.6. Maximum bar spacing

This value is limited so no areas remain without reinforce-
ment. It can be considered as it being a minimum condition
to be able to refer to it as ‘reinforced concrete’ and not
‘mass concrete’.

2.4.2.7. Minimum bar spacing

So concrete may be poured correctly, the reinforcement is
to have a minimum free distance between its bars. This va-
lue used is that of the corresponding code.

2.4.2.8. Bending in the footing

Bending is checked at the reference section situated at
0.15 times the width of the wall towards the inside of the
wall. When designing for bending, footing depths are provi-
ded whereby compression reinforcement is not required. If
tensile forces appear at the top of the footing, a top reinfor-
cement mesh will be placed.

2.4.2.9. Shear

Shear is checked at the reference section situated at a dis-
tance equal to the effective depth from the edges of the
wall. When designing for shear, footing depths are provi-
ded so no transverse reinforcement is required.

2.4.2.10. Geometric and mechanical ratios

The program checks the geometric and mechanical steel
area criteria specified by the code are met.

CYPE
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2.4.2.11. Geometry design

The program allows the user to design the geometry of the
wall elevation and footing.

The design criteria used for the wall elevation is:

• Top thickness = 0.25 (h)

• Bottom thickness = 0.11 × equivalent soil height (h).
The program calculates the moment at the start of the
wall due to the backfill soil and at the top of the wall.
Based on that moment, the equivalent soil height is cal-
culated, i.e. the height that would produce the same
moment as that previously calculated.

The design criteria used for the footing is:

• Depth = greatest value of the following:

a) 0.10 × Equivalent soil height (h)
b) 0.50 × Maximum overhang (If the option Job > Op-

tions > Footing > Design depth as > Rigid has
been selected)

c) 0.33 × Maximum overhang (If the option Job > Op-
tions > Footing > Design depth as > Flexible
has been selected)

• Overhangs. The overhangs are designed in such a way
that the footing is in equilibrium (overturning and sli-
ding) and the allowable bearing pressure of the soil is
not overcome.

CYPE
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3.1. Assistant
When creating a new job, the program offers the possibility
to use an assistant, which generates the necessary data to
describe the wall based on a reduced number of parame-
ters introduced sequentially by the user. It includes the pre-
design of the geometry and the load generation. Any data
that is generated can be revised and/or modified once the
job has been generated.

Fig. 3.1

Fig. 3.2

3.2. Reports
Reports can be obtained using the following option File >
Print > Job report.

The reports may be printed out via printer (with optional
previous view, page setup, etc.) or generate HTML, PDF,
RTF or TXT files.

Fig. 3.3

3. Program description

CYPE
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3.3. Drawings
Drawings can be obtained using the option File > Print >
Job drawings.

The following options can be carried out:

• The Drawing selection window allows the user to add
one or several drawings to print out simultaneously and
specify the output peripheral: printer, plotter, DXF or
DWG; select a title block (CYPE’s or any other defined
by the user) and configure layers.

Fig. 3.5

• The elements to be printed can be configured for each
drawing, with the possibility to include previously impor-
ted user details.

Fig. 3.4

CYPE
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Fig. 3.6

• Modify text positions.

Fig. 3.7

• Place objects in the same drawing or move them to
another drawing.

Fig. 3.8

CYPE
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